Digital Video Capture and Edit with iMovie HD 6.0.2
Project Management
Plan out your time and process before beginning the capture and edit. A few
major items to keep in mind:
1. Uncompressed digital video files (DV) are VERY large. You will not be
able to save the raw files for your project into any of your network spaces.
In most cases your raw files will not even fit on a CD.
Uncompressed digital video files (DV) require up to 3.5 MB of space for
every second of footage, thus:
• An empty CD-R will hold only about 2.5 minutes of uncompressed
DV clips
Therefore, it is advised you use an external hard drive to save your
materials. Small flash or travel drives are also not adequate for storing
video projects. Due to system specifications demanded by iMovie HD, it is
best to borrow one from the Equipment Loan Center (http://oit/eqloaning/)
2. Plan how you will use your finished movie before you begin. Poperly
compressed QuickTime movies can be played on the web, sent through
email, and posted to GLOW or Blackboard. Compressed QuickTime
movies that are under 3 minutes should be small enough to save to a
network space or to attach to an email message. Uncompressed, fullquality DV can be burned to a standard DVD directly from iMovie using
iDVD

Preliminary Set Up

•
•
•
•

Launch iMovie HD 6 (located in “Multimedia” folder on the Dock). iMovie
should present you with three options:
1. Create a New Project (Allows you to start from scratch and work with all
the options iMovie has to offer)
2. Open an Existing Project (Allows you to pick up where you left off)
3. Make a Magic iMovie
Choose option 1. Create a New Project. In “Project” type an appropriate
name, and in “Where” select your external hard drive. IF you do not have

an external drive you should choose “Desktop” as a local storage option.
Also, check that the Video format is DV (click on arrow to see format).

Your project is now ready to work in, Before importing media for editing,
double check these iMovie settings:
From iMovie HD menu (top of
screen) choose Preferences:
*Under the Import tab, ensure that
“Automatic DV Pillarboxing &
Letterboxing” is unchecked.
*Under Playback tab ensure that
“Play DV project video through
to DV camera” is unchecked.

The iMovie Interface:

Capturing (recording) a Video Clip
1. If capturing from a camera: connect dv out from camera to computer
firewire port and turn camera on in Playback mode. Make sure the iMovie
Capture/Edit toggle is pushed to the left towards the camera icon.
2. Cue up footage in your camera to a few seconds before footage you want
to capture. You will be able to trim the excess off later. You should be
able to see the paused movie in the movie window on your computer.
3. When you are ready to begin recording, press play on the camera and
click the IMPORT button in the iMovie Viewer window. iMovie will begin
capturing.
4. To stop capture, click on the IMPORT button again. The movie clip will be
named Clip 01 and placed into one of the bins to the right of the viewer
window.
5. Repeat the capture process, starting with step 4 above, for any additional
clips. NOTE: You can capture from VHS and DVD by using a station
configured with a “Capture Box”.
Editing Clips
iMovie HD is in Edit Mode when the Capture/Edit toggle is pushed to the right,
(toward the scissors icon). In Edit Clip Mode, you can change the speed,
direction and order of your clips. You can also split clips and add titles and
transitions between clips to replace jump cuts. Audio sounds can be added from
built-in sound effects, CDs, and voice recordings.
Placing and Cropping a Clip
1. Drag a clip from the bin to the timeline at the bottom of the window. You
can play the clip by using the set of iMovie HD controls below the viewer.
The number displayed next to the playhead is the number of seconds and
frames up to that point in the movie. (For example, a time of 03:15 would
mean 3 seconds and 15 frames.)
2. When you are ready to edit the clip, drag on the gray triangles below the
viewer. Drag the first triangle to the place on the timeline that you would
like your clip to begin. Drag the second triangle to the place on the timline
that you would like your clip to end. The clip’s timeline will be shaded
between the start and stop points.
3. When you have positioned your start and stop triangles where you want
them, go to the Edit menu and choose Crop. This will crop the movie clip
to the portion that you have selected (The yellow portion of the timeline).
You can bring multiple clips to the timeline in this fashion and edit to add
them to your movie
4.
Splitting Clips
You can split single clips into two clips. This is useful if you want to keep an
unused portion of a clip on the shelf for later editing. It will save you from having
to recapture content.
1. Click once on the clip you want to split in the timeline.

2. Movie the playhead on the timeline bar under the monitor to the frame
where you want to split the clip.
3. From the drop down menu, select “Edit  Split Selected Video Clip at
Playhead.” The clip will split into two individual clips.
Creating a Still Clip (single frame shot)
1. Select the desired clip and move the playhead to the frame you want to
take a still frame from.
2. From the drop down menu, select “Edit  Create Still Frame.” The clip
will remain still for its entire duration.
Changing a Clip’s Speed or Reversing a Clip’s Direction
1. In either the timeline or clip view, click once on the clip you want to adjust
once to highlight it.
2. Click on the Editing button below the clips pane and then click on the
Video FX button on the top right.
3. Select Fast/Slow/Reverse effect from the list of video effects that appear
(see below)
4. Locate the Faster/Slower option at the bottom and drag the blue knob
horizontally to alter the speed, or click the Reverse Direction box to
change the direction of the clip.
5. You will be able to preview the changes you make in the iMovie viewer.
6. Click the Apply button when you have the effect you want.
Adding Titles
Titles add descriptive text to your movie. You can use a variety of title styles,
fonts, and colors. Titles can be superimposed over portions of clips or added
over black as a separate clip. You can also modify titles after creating them. To
access the title editing options, click on the Editing media tab and choose the
Titles tab.
Adding a Title Over a Video Clip
1. Select the desired clip in the Timeline or Clip viewer.
2. Click the Editing button located beneath the clip pane, and then choose
the Titles tab (see image above).
3. Click on a style from the scrolling list in the titles palette (Bounce-IntoCenter, Centered Multiple, etc.) to select it.
4. Choose a font for your title from the font popup menu.
5. Uncheck the Over Black box if it is selected.
6. Choose a color by clicking on the Text Color box next to color and clicking
on the desired color. Select the desired size by sliding the blue knob size
horizontally between the small ‘A’ and the large ‘A.’
7. Type the text for your title into the text field(s) in the titles palette.
Depending on the style, there will be different options in the number of text
fields, direction of entry, etc.

8. In the titles palate, slide the blue knob to designate Speed (at which the
title solidifies) and Pause (duration of appearance).
9. Click the Preview play button beneath the iMovie monitor to see a preview
of the title over the clip.
10. Click the Add button in the titles palette to add the title over the selected
clip. To add a new clip (rather than just adding a title to an existing clip)
with the content of the selected clip plus the title, drag the highlighted title
style from the style list in the title palette in front of the selected clip in the
Timeline or Clip view. A title clip should appear in the clip viewer and a
red progress bar under the clip indicates the time remaining to render the
title. The rendering (processing) of the title will vary according to
pause/speed input.
Adding a Title over Black
1. Click the Editing button located beneath the clip pane, and then choose
the Titles tab.
2. Click the Over Black box to check it.
3. Continue with steps 3-9 as described under Adding a Title Over a Video
Clip above, skipping step 5.
4. Select a clip in the Timeline or Clip viewer and then click the Add button in
the titles palette. The title over black clip will be added before the selected
clip.
Editing Titles
1. Select the desired clip in the Timeline or Clip viewer.
2. Click the Editing button located beneath the clip pane, and then choose
the Titles tab (see image above).
3. Make the desired changes (see steps 3-10 under Adding a Title Over a
video Clip above).
4. Click the Update button in the titles palette.
Transitions
Transitions smooth the cuts between the clips. They can be added either to the
beginning or the end of a clip or between two clips. To access transitions, click
on the Editing media tab, and then choose the Transitions tab.
Creating a Transition
1. Click on the Editing button located beneath the clip pane, and then choose
the Transitions tab (see image above).
2. Select a transitions style (Circle Closing, Circle Opening, etc.) in the
Transitions palette by clicking on it.
3. Drag the round blue knob beneath the preview screen within the transition
palette to alter the speed of the transition.
4. For some transitions (Push, Billow), you can choose the direction of the
transition using the four direction buttons to the left of the speed setting in
the transitions palette.

5. Click the preview play button beneath the iMovie monitor to see a preview
of the transition between the clips.
6. Drag the highlighted transition style (Circle Closing, Circle Opening, etc.)
in front of the clip in the Timeline or Clip viewer where you wish the
transition to appear.
Editing a Transition (remove and re-do!)
1. Select the transition box in the Timeline by clicking on it once to highlight
it. Hit Delete key (on keyboard).
2. Create a new transition if desired.
Inserting Pre-Recorded Sounds
1. Click on the Media tab and then choose the Audio tab.
2. Choose one of the audio sources on the list. You can choose from built-in
sound effects, Garage Band, or your iTunes library and play lists. Choose
the sound track that you wish to insert.
3. Move the play head to the frame where you want the music or sound to
begin. Click on the ‘Place at Playhead” button below the play list. The
audio file appears in the second audio track. You can also drag an audio
file into the timeline view.
Note: To use music from a CD, you should first import the song into iTunes.
Inserting your own recorded voice
1. Click on the Media tab and then choose the Audio tab.
2. Click the red button on the bottom right to start recording through the
external microphone. Click the red button again to stop recording. The
voice will record directly to the first track on the Time Line Viewer and will
appear in orange.
Note: For the highest quality recording, use a USB mic/headset available for use
in the Media Education Center (Jesup 316).
Editing the Audio
Using the Volume Control
1. Select the desired clip in the Expanded Timeline view.
2. Go to the volume control under the Timeline and drag the knob to
increase/decrease volume.
Controlling the Volume Within an Audio Clip
1. Select the desired audio clip in the timeline view.
2. In the drop down menu, select “View  Show Clip Volume Levels.”
3. Purple lines will appear in the audio clip to represent the volume level.
4. Click and drag purple lines to adjust the volume within the audio clip
(i.e. fade in and fade out volume).
Dividing an Audio Clip
1. In the Audio track, select the audio recording you wish to split.
2. Drag the Playhead to the desired split point.

3. In the drop down menu, select “Edit  Split Selected Audio Clip at
Playhead” and the audio clip will split into two individual audio
segments.
Editing the size of an audio clip
1. Drag the ends of the tracks in audio tracks to edit the size of the audio
clip. To drag the ends of the track, place the cursor over the end of the
clip until the drag icon appears. Click and drag to adjust the clip size.
Effects
Inserting a Video Effect
1. Select the desired clip in the Timeline.
2. Click on the Editing media tab.
3. Click on the Video FX tab
4. Select an effect by clicking on one in the effects list (see image below).
5. Move the effects in/effects out slider to the points in the selected clip
where you want the effect to appear and disappear.
6. Move the appearance sliders to make adjustments to the selected
effect. These options will vary depending on the effect you choose.
7. Click the Preview button next to the clip preview.
8. Click the Apply button to enact the effect.
Inserting an Audio Effect
1. Select desired clip in the Timeline.
2. Click on the Editing media tab.
3. Click on the Video FX tab.
4. Select an effect by clicking on one in the effects list.
5. Move the effects controls to make adjustments to the selected effect.
These options will vary depending on the effect you choose.
6. Click the Preview button next to the clip preview.
7. Click the Apply button to enact the effect.
Adding Photos
You can drag images directly into a bin or Import from computer:
1. Click the Media tab and then click the Photos tab at the top.
2. Select the iPhoto library, an album, or a folder in the list at the top. The
photos in the selected folder or library will appear in the list at the bottom
of the pane. Scroll through the pictures to find the one you want.
3. As you click on a photo, select the Show Photo Settings button at the
bottom of the pane and the photo settings window appears (see below).
4. Click the Ken Burns effect checkbox to deselect it and turn off motion for
the picture (The Ken Burns effect causes the movie to zoom in/out of the
photo).
5. Drag the duration slider to change the display duration of the photo (By
default, iMovie sets the photo duration at 5 seconds).

6. Drag the photo from the Media pane to the Timeline.

Output to Camera, iDVD, CD (Web) or QuickTime (.mov)
1. Go to Share menu and choose (format of your choice) that you want to
output your movie to. For example, you can output it to a tape in a video
camera, burn an iDVD, or save it as a QuickTime movie.
2. There are a number of export options available via the tabs listed. Use
the pull-downs menus within the dialogue box to set specifications for your
movie output. Note: Export Full Quality QuickTime (.mov) file for use in
other editing programs like Final Cut Pro, After Effects, or Motion. When
choosing iDVD you will need to set up the menu for playback in that
software before burning – iMovie will launch iDVD for you and place your
project in the default menu template.

